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1. MAPINFO BASICS  

This guide is intended primarily for Map Room users, but may be of interest to other University 
students and staff, or indeed the wider community. References to tables, folders etc., are not 
applicable outside the Map Room, so if you are located elsewhere, you should substitute your own.

 

  

MapInfo and the datasets available in the Bodleian Library Map Room can only be used for 
education and research purposes. It is not licensed for commercial publication or other 
purposes. There are also restrictions on the use of Ordnance Survey and Census boundary data 
- please ask for further information. 

 

  

Tables, tables...  

MapInfo may appear at first to be a complex application, but whilst it is powerful it is also 
straightforward to use, once some basic concepts are understood. Please remember that this is 
not an exhaustive guide to MapInfo - if you need more help or would like to discuss your 
mapping requirements please ask at the Map Room Enquiry Desk. 
All data is stored as table (*.tab) files. These tables can contain just data values or data which 
has associated graphical data (symbols, lines etc.). If the table contains data only, then it can 
only be displayed in a browser window. 
A browser window looks like a simple spreadsheet table, with columns and rows. If the table 
has associated graphical data then it can be displayed as a map in a mapper window.
You change an unmappable (browser) table to a mappable table by creating graphic data, as 
explained further on. 

 

  

Layer by layer…  
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Tables can be layered to build up composite maps. For example you could combine a coast 
layer with a rivers layer to produce a simple hydrologic map. 
The layers can be ordered as you wish, so that if you add a roads layer it can be placed above 
the rivers layer! New layers can be added or removed as required. 
You can import your own data, either points (with coordinates) or thematic. Point data can be 
used to show spatial distribution of data and you can choose from a range of symbols to 
represent your data.
Multiple data layers can be used to show several datasets simultaneously. With thematic data 
you can create a shaded world map showing demographic data, for example.
Maps can also be customised (i.e. line style and colour, polygon fills and point styles can all 
be changed), so you do not have to use the default colours and styles. When you have created 
the map, you place it into a layout window. This enables you to position the map on a page, 
add a scalebar, title, key and any other details which are needed to complete your map. You 
can also add additional maps, such as location maps, enlargements etc., to your own 
requirements. 

 

  

Save it or lose it!  

  

It is most important that you save your work as your map progresses. You can then stop at any 
point and return to it another time, carrying on from where you left off. 
You do this by saving your map(s) in a workspace. A simple analogy of a workspace is to 
compare it to a recipe. The workspace file contains a list of the tables you have used (the 
ingredients) and their zoom levels, geographic limits, style settings etc., and most importantly, 
your layout window settings (i.e: how to 'cook' your map). 
The workspace can then re-create your maps each time you load the workspace file. One 
important difference between the workspace file and a recipe is that it also records where the 
tables are located (i.e: which cupboard the ingedients are in). So do not move files around and 
certainly do not delete any! If you do, you will not be able to open the workspace. (Although 
the workspace is a simple text file, think very carefully before attempting to edit it. This may 
be the only option if you have moved some tables and cannot remember where they should be, 
or have deleted some entirely, but it is very risky!) 
You should create a workspace fairly early in your session and regularly save it so it is up to 
date. You then have a backup in the event of a disaster! When you create workspace file(s) - 
you can have more than one if you wish to keep two or more versions of your work - on the 
Map Room workstation they should be saved in a personal folder in the usrfldrs folder on 
drive D.

 

To create your folder, select drive D, then look through the list of folders and open the folder 
called usrfldrs. Click the New Folder button to create a new folder, naming it with your name. 
Always use this folder to save downloads and other files.

 

2. Let's make a map
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2. LET'S MAKE A MAP
This guide is intended primarily for Map Room users, but may be of interest to other University students and 
staff, or indeed the wider community. References to tables, folders etc., are not applicable outside the Map Room, 
so if you are located elsewhere, you should substitute your own.

 

MapInfo and the datasets available in the Bodleian Library Map Room can only be used for education and 
research purposes. It is not licensed for commercial publication or other purposes. There are also 
restrictions on the use of Ordnance Survey and Census boundary data - please ask for further information. 

 

Start MapInfo (good, that's the easy part done…)
The first thing you see when you start a new session is the Quick Start dialog. This gives you a selection 
of options, depending on how you wish to proceed. 
To start a new map from scratch, click the Open a table option, then OK. You can then strat opening 
tables to create your map.
If you have already created a workspace in a previous session, click Open a workspace, then OK . Find 
your workspace file and open it. You can then carry on with your map.
If you were the last user, your workspace will be named, so just open it again. If you exited MapInfo 
without saving a workspace (oh, dear...), you can recover your work by selecting Restore previous 
session. This can be a lifesaver, but it is better to save everything before exiting! 
Alternatively you can click the Cancel button to remove the dialog, then open the File menu and click 
Open Table, or you can use the Open table speedbutton below the menu bar. To open a workspace from 
the menus, open the File menu and click Open workspace.

 

Data, data everywhere...
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There is a considerable amount of data available on the Map Room workstation and it is listed in the 
Datasets section of this guide. However, let's make a simple map to start with so you can see the 
principles in action.
For this example we will use the outline World map which is supplied with MapInfo. To open this, click 
Open a table on the Quick Start dialog (or File>Open table if it is not displayed), then open the MapInfo 
folder on drive D. Open the Data folder and then the World folder. (if you are following this on another 
workstation you will have to locate the table yourself). Select the file world.tab and click Open. 
You will now see a basic outline world map. Note that as this data is mappable, it opens automatically in 
a mapper window. If the data was not mappable, it would open in a browser (this is explained further in 
the next section). 

 

Tables, layers: the same but different...

 

You may think that tables and layers are one and the same, as tables create layers in a map. Well, they 
are.. but then again they are not!
A table is mappable if it has graphic objects associated with the data (the table worldcap.tab has a star 
symbol associated with each record in the table). therefore a mappable table can be used as a layer in a 
map. However if the table is not mappable (because it is simply data, without any associated graphic 
objects) it cannot be used as a layer, but it is still a table and can be displayed in a browser window (like 
a spreadsheet).

Now back to the World map which you have opened. If you cannot see the whole world, click the right 
mouse button while the pointer is in the mapper window and select View Entire Layer from the popup 
menu. At the moment you only have one layer, which is world, so click OK and the map will resize to fit 
inside the window.You can try the other navigation tools as well. There are two zoom buttons (they have 
a little magnifying glass with "+" and "-" for zoom-in and zoom-out respectively). To move the map 
around, use the grabber tool (a white hand). Click and drag with the left button to reposition the map - 
this is much easier than using the scroll buttons!
Now we can add a second table, so click File>Open table again and open the table worldcap.tab which is 
also in the World folder. You will now see world capitals displayed on the map. Note how the worldcap 
table opened in the same mapper. This is because MapInfo detected that the two tables covered a similar 
area and were the same projection, so they would layer automatically. 

 

Everything under control
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Ok, so now we have a world map with capital cities . 
Suppose we want to change the appearance of the cities, or make other changes to the map. This is where 
the Layer Control is used. The layer control is can be accessed in two ways, depending on how you like 
to use the mouse.
It has a button in the main 
toolbox (half way down on the 
left, it looks like a stack of three 
sheets). Alternatively, right-
click with the mouse, and it is 
the first option on the popup 
menu. Either way, open the 
layer control now.
You will see a list of layers, 
with a set of checkboxes and 
several buttons. The list contains 
the two layers which are 
currently open, with an 
additional layer at the top. 
This top layer is called the 
Cosmetic layer and is always 
present. Think of it as a 
transparent overlay on which you can draw lines, boxes, text or whatever. We will come on to using it in 
a moment.
You will see that the worldcap table has been placed above the world table. This is a feature of MapInfo, 
which is that points and lines are placed above regions automatically. If the worldcap table was below 
the world table, the symbols would be hidden. You can see this by clicking once on the worldcap layer 
and then clicking the Down button in the Reorder box to place it below the world layer. Click OK and 
you will see that any symbol which was within a land area has disappeared. Open the layer control again 
and move the worldcap layer back up again. Do not click OK yet. 

 

Colours and symbols and styles...Oh my!

On the right of the layer control you will see a button labelled Display. This enables you to change the 
style of any layer. We will come on to the four check boxes next to each layer in a moment, but you will 
find that the second checkbox is greyed when you open data sets in the Map Room, so you cannot click 
it. This shows that the table is read-only, so you cannot make changes to it.
All the datasets are read-only to prevent users editing them (you may like pink rivers on your map but 
the next user may rather have the standard blue ones…). This suggests you cannot change the colours 
and styles - well you can't permanently, but you can override the settings for your own map. This means 
that the original data is unchanged, but the override settings are stored in your workspace so they will be 
applied each time you open your map.
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This is where the Display button is used. Click 
once on the worldcap layer to highlight it, then 
click the Display button. You will now see the 
Display Options dialog for this layer.
This contains several features, but we are only 
concerned with the Display mode section at the 
moment.
You will see a checkbox Labelled Style override - 
click this and a large button will be enabled. Now 
click the button to display the style dialog. As we 
are overriding a symbol object, we can choose the 
symbol style, colour and size. There are a number 
of symbols available, ranging from simple 
geometric shapes to cartographic and other 
pictorial styles. For this example, choose from the 
MapInfo 3.0 compatible set and choose a filled 
square (the one with a grey fill, not the outline 
one). Choose another colour, say blue and make 
the size slightly larger. Now click OK in each 
dialog in turn, finishing with the layer control - 
the cities are now represented by blue squares.
Now change the style of the world map. Open the 
layer control again, highlight the world layer this 
time and click Display. Enable style override 
again and click the big button. Now you are 
changing a region object, so you can choose the fill pattern (solid black simply means a solid fill and N 
means no fill), the fill colour, border style, colour and line thickness. Make a few changes and then OK 
everything and see the difference. Remember that the style can be changed at any time - and it will only 
be saved if you save a workspace. 

Let's be selective

You will see that any style change applies to the entire dataset - all symbols change for example. What if 
we wanted to make selective changes - say make London a big green circle but leave the others as red 
stars?
Well, if the table is read-only then the short answer is you can't!
This is because changing individual objects within a layer means editing the layer, which you cannot do 
if it is read-only. So how do you do it? Well, you make a copy of the table you wish to modify, as this 
copy will then be editable. However you should remember that some datasets can be 20Mb or more in 
size! You would normally be working on part of a dataset, so that although a map of the UK could be 
using a worldwide dataset, you only need the UK part of it. Copying part of a dataset is more practical 
and is the normal procedure. 
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I'll have that and that and that and... 

Zoom in to a smaller area, using the zoom-in control (a magnifying glass with a "+"). You can either 
click once to double the scale (reduce the area) or drag a box around the area by starting at one corner 
(say top left) and holding down the left mouse button while you drag.
When you release the button it will zoom in. Zoom in to an area which shows two cities, say London and 
Paris. We will now save a copy of these two cities and if you are using the Map Room workstation save 
these into your own user folder.
If you do not already have one, create one now, as explained in Appendix A, and while you are at it, save 
a workspace. Assuming you have a folder to save tables in, you can now select the two towns. MapInfo 
has a number of selection tools. The simplest is the pointer, which can be used to click on a single object. 
To select a number of objects at once, use the Marquee select tool, to the right of the pointer tool (tip: if 
you pause the cursor on a tool, a hint will appear telling you what it is!).
To use the marquee tool, just drag a box around a group of objects to select them all. If the objects 
cannot be contained with a box (say you want all the towns within a single country) then use the Region 
select tool. You simply click within the containing boundary and all the objects are selected. Other 
selection tools select within a given radius, or can draw an irregular shaped region to select within. As 
we are only selecting two cities, click the first one with the pointer tool, then hold down the shift key and 
click the other one. Both objects are now highlighted.
To save them, open the File menu and click Save copy as… A list will appear of all the currently open 
tables, together with a table called selection - this is your selected objects - so highlight it and click 
Save…

Click on the object, not a label! - When selecting objects (regions, points or lines) make sure that you 
click the object itself, not a label. The objects themselves need to be selected to save them. Labels are 
simply attributes of the the objects and will be copied with the objects anyway, but you will need to 

display then again when you open the saved table.

Save the table in your own folder, and give it a descriptive name, such as LondonandParis. The .tab 
extension will be added automatically. Now open the Layer control and highlight the worldcap layer. 
Click the Remove button to remove it from the list. Close the Layer Control again.
You can now open your saved table by clicking the open table speedbutton (or File>Open table). Open 
the new table and the two cities will appear on the map.

Be careful - When a layer is editable it is at risk - you can accidentally move or even delete objects with 
realising it, so take care. As soon as you have finished editing a layer, open the layer control and uncheck 

the edit box to protect it.

Let's be individual...

When we changed the symbol style for the worldcaps layer, all the symbols changed - we could not have 
different symbols for some cities. However if a layer is editable, then individual symbols can be changed.
Open the layer control again (you do this rather a lot in MapInfo…). You will see your new layer has 
appeared. The edit checkbox (the second one) is enabled, so click it now to make the layer editable. 
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Click OK to close the Layer Control.
If you now click the symbol for London, it will appear slightly different - the symbol has a 'hotspot' at its 
centre. If you are particularly observant you will also have noticed that the drawing tools are enabled. 
You can move the symbol by dragging the hotspot around, but note the warning above! We don't want to 
move it, so just leave it selected. 
To change this symbol, click the Symbol Style button (it is near the bottom and has a map pin with a 
question mark) on the drawing tools to display the symbol dialog. Choose a new symbol style and colour 
and click OK. The symbol for London has now changed. It is very important to understand the difference 
between using style override and making a symbol/object editable and then changing its style. In the 
latter case you are permanently changing the object, whereas in the former case you are temporarily 
changing it.
If you have used the table in another workspace and you edit it, then it will be changed there also, but 
using style override changes it only in the current workspace. Remember also that style override is only 
saved in a workspace. So: 

Style override:

Can only be applied to entire layer

Will only be saved if you create and save a workspace

Does not change table itself so will not affect other workspaces

Can be changed back by unchecking Style override in display dialog.

Edit object/symbol

Can be applied to a single object or symbol (or selection of objects/symbols)

Will only be saved if you save the table, BUT:

Changes table itself and therefore affects any other workspace using the table

Cannot be changed back (unless you remember the original style!) 

 

 

Draw me a picture...
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So now we have a basic map, but perhaps it could do with some extra touches, such as a box around the 
UK, for example, or some other annotations. 
You can do all this using the drawing tools, but as we do not want to draw directly on to the 
map layers (as we may want to change things, and if the layer is read-only you cannot draw 
on it anyway), such cosmetic changes to the map are made on the… Cosmetic Layer!
The Cosmetic Layer is a fixed layer (you cannot move or remove it) and is always the top 
layer. Think of it as a transparent surface over the map which you can draw on. 
To draw on the cosmetic layer, first open the Layer Control and make the Cosmetic Layer 
editable. When the Cosmetic Layer is made editable, the drawing tools become enabled The 
first nine buttons counting down from the top left select the type of object to be drawn (or 
in the case of the A button, write text). The four lowest buttons with a ? next to the object 
set the style for symbols, lines, polygons and text. In between are some special tools which 
we will come on to later. 

 

A circle, or a star, or a box…or perhaps a cute little duck…

It is easier to select a style first, then draw the object or place the symbol, but you can always change an 
object once you have drawn it by double-clicking it. 
You will then see a dialog which has a style button and boxes to enter precise coordinates (and size in 
the case of objects). The symbol tool (top left) places a single symbol on the map at the point you select 
by clicking with the mouse. There are plenty of symbols to choose from. You can use simple geometric 
shapes (circles, squares etc) from the MapInfo 3.0 set, or pictorial symbols from the cartographic, 
miscellaneous, real estate etc., sets. The latter sets are True-type symbols (like the fonts in Word) so they 
can be rotated and be given borders and shadows.
Top right is the line tool, which draws a single straight line between two points - just hold the left mouse 
button down and drag a line. Second down on the left is the polyline tool. This draws a segmented line. 
Click once to start, then click at each point you wish to change direction. Double-click to finish. Second 
right is the arc tool (which draws arcs…). 
The next four buttons draw region shapes. The first one draws a polygon (a polyline but with a fill). The 
next is an ellipse (tip: hold down the shift key and it draws a circle). Below is the rectangle tool (yes, 
you've guessed it: hold down shift and it draws a square!). Finally there is the rounded rectangle tool. 

 

Oops! I've gone crooked...
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If you have drawn a polyline, for example and it's not quite right, how do you edit it? Try clicking once 
on the line to select it, then drag one end with the mouse - the whole line moves around! (the same thing 
happens with straight lines and regions).
When you draw a line, each end of the line terminates in a node. A polyline also has nodes at each 
change of direction (or angle in the case of a polygon) and a box, rectangle or ellipse/circle has just four 
- one at each corner. Okay, so circles do not have corners, but the nodes are at the corners of its bounding 
rectangle (a rectangle which just encloses the object).
So to change the shape of a line for example, or move just one end of it, we use the Node editor, which is 
the button below the text tool.

NB: The layer containing the object must be made editable before the node tool can be used - it is 
disabled if the layer is not editable. Remember that you are making changes to the table, so save it 
afterwards.

Click the line or object to edit, then click the Node Tool. You will now see the nodes in your line or 
object (nodes occur at each change in direction as well as the start and end). Now you can move an 
individual node as you wish. Suppose you have missed an angle? To put a 'bend' in an otherwise straight 
section, use the Add node tool, which is next to the node editor. Click it first, then click on the line or 
object to add nodes as required. Nodes can be moved along a line to reposition them and if you have too 
many, then delete them by clcking once on the node to select it then press the hit the delete key. TIP: If 
you have drawn an object, an wish to add another which joins exactly to it (such as extending a river or 
creating adjoining polygons), use the SNAP function. Snap works by attracting a node to another, so as 
you bring the line towards an existing line, it will 'snap' exactly to it. To use snap, just press 'S' on the 
keyboard. As you approach an existing node a cross will appear and the new node will be snapped to its 
neighbour. To turn snap off, just press S again. 

 

That's enough for now...

This has covered the basics of creating and annotating your map. You should now be able to open and 
modify tables, make selections of objects and annotate your maps (and if you can't then just go right 
back and read it again…) The How to guides give step-by-step instructions for a range of further 
activities, such as using your own data, multiple maps etc., so it is not included here.

 

3. Time to put it all on paper

Nigel James
Bodleian Library 2000
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3. TIME TO PUT IT ALL ON PAPER 
This guide is intended primarily for Map Room users, but may be of interest to other University students and 
staff, or indeed the wider community. References to tables, folders etc., are not applicable outside the Map Room, 
so if you are located elsewhere, you should substitute your own.

 

MapInfo and the datasets available in the Bodleian Library Map Room can only be used for education and 
research purposes. It is not licensed for commercial publication or other purposes. There are also 
restrictions on the use of Ordnance Survey and Census boundary data - please ask for further information. 

 

If you wish to print your maps, you should create a layout. This enables you to arrange your maps, 
legends and title etc, on a page which appears on screen as it will be printed.
Each map (which may contain 
several layers) will appear on 
the layout in a frame. The frame 
acts a placeholder for the map 
and can be positioned and sized 
as required.
To create a layout, open the 
Window menu and click New 
Layout Window. You will see 
this dialog: 

If you have used a desktop publishing package such as Freehand or Corel Draw then you may be familiar 
with the concept of frames. Any changes to the content of the frame is done in the object's window. (This 
means that to add a layer to a map, for example, you do this in the mapper window, not the layout 
window - the layout is automatically updated).
If you have one mapper or browser window open, use the first option - One Frame for Window and click 
OK.
If you have several windows open then use the second option to create a frame for each window. 
Alternatively select the third option to create a blank layout, to which you can add frames as required. If 
you select the first or second options, you will see a layout window displayed, containing one or more 
objects. You can change the page size and orientation by opening the File menu and clicking Page 
Setup. Choose your settings and click OK.
Sometimes you may find that your layout is across two or more pages (MapInfo can create multipage 
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layouts if required). To return to a single page layout, open the Layout menu and click Options. Set the 
number of pages as required. The Show Frame Contents option should be left at Only When Layout 
Window is Active, to speed up display time.

 

Now that goes there, and this goes here…

You can position the frame and resize it as necessary. To set the size and position of a frame precisely, 
just double-click it - you will then see the Frame Object dialog. Just make any changes required and 
click OK.

 

"This is my first map..."

To add text (a title, for example) click the Text Tool (the button with a letter A) in the drawing toolbox. 
Click anywhere on the layout window and type your text. You can set the font size, style and other 
options first if you wish by clicking the Text Style button (the A? button).
Alternatively you can change the text after typing it by double-clicking the text string using the select 
tool. This is also how you edit text once it has been typed. 

You have a choice of views for the layout window: To see the layout at 1:1 size, right-click on the layout 
and choose View actual size from the pop-up menu. To see the entire layout, select View entire layout 
instead. When adding text etc, always work at actual size as you can then see just how large or small the 
text will be. 

 

Get in line there!
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MapInfo has alignment tools to position map frames and text etc, precisely. You can align maps and text 
with the whole page, or with each other.
To see how this works, click once on the map with the left button to select it, then click again on the 
map, but this time with the right button. From the pop-up menu select align objects.
You can set the horizontal and vertical alignment of objects, either with relation to the entire layout, or to 
each other. Both positions have a 'don't change' option, to leave that position as it is. If you have a 
number of objects you can also space them equally, which is useful for simple legends, for example. 

In the align objects dialog, choose the following: Horizontal: Align center of selected objects with 
respect to Entire layout. Vertical: Align center of selected objects with respect to Entire layout. Click 
OK. The map will be in the centre of the page! Now add a title to the map by choosing a suitable font by 
clicking the Text style button in the drawing toolbox and selecting say, Arial 20pt. Then click the Text 
button and click once roughly where the text should go. Type a title, then click the pointer button in the 
main toolbox when you have finished. Do not press Enter or you will simply add another line of text.
Move the text to the position you would like, just above the map, for example. Don't worry about getting 
it in the center of the page as we will use the align function for this. We will now align the two objects 
(map and title) with each other. Click once on the map to select it, then hold down the Shift key and click 
the title to select that as well. Release the shift key and right-click on either the map or the text (it doesn't 
matter which)
In the Align Objects dialog, choose Align center of selected objects with Respect to each other for the 
horizontal alignment and in the vertical alignment choose Don't change. Click OK and the text will stay 
the same distance above the map, but it will now be aligned with the map as well.

NOTE: When aligning objects with each other, remember that the first object you select will not move, 
but the other objects will move to align with it. If we had clicked the title first, then shift+clicked on the 
map, the map would move to align with the title, which was not what we wanted. Also:
Horizontal alignment means alignment along the horizontal plane, not moving the horizontal position up 
or down the layout.
Vertical alignment means alignment along the vertical plane, i.e: up or down the layout. 

 

If the printed colours are not what you expect, download and print the MapInfo Colour Grid table 
- you can then select colour styles in your tables to match the required print colours. 

4. Data analysis and display - real GIS stuff!

Nigel James
Bodleian Library 2000
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4. Data analysis and display - real GIS stuff!
This guide is intended primarily for Map Room users, but may be of interest to other University students and 
staff, or indeed the wider community. References to tables, folders etc., are not applicable outside the Map Room, 
so if you are located elsewhere, you should substitute your own.

 

MapInfo and the datasets available in the Bodleian Library Map Room can only be used for education and 
research purposes. It is not licensed for commercial publication or other purposes. There are also 
restrictions on the use of Ordnance Survey and Census boundary data - please ask for further information. 

 

For more advanced use of MapInfo, including displaying and analyising your own data, using scanned 
maps, creating grid thematic maps, using queries and so on, see the MapInfo How To guides, which 
explain a number of procedures in a step-by-step way. However, just to see how MapInfo can be used to 
display data, here's a simple introduction which creates a ranged thematic map (shading by colour 
according to values), using the World map you have open already.

If the layout window is still displayed, click the mapper window if you can see it, otherwise open the 
Window menu and select the World map… window.

 

Three steps to Heaven (or to creating a thematic map anyway…)

Creating a thematic map in MapInfo requires just three steps:

1. Choose the type of map

2. Select a table and a data field (or fields)

3. Preview the results and make any changes, then display the map 

 

Step One
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Open the Map menu and click Create Thematic map...
Chose the type of map. For single variables, you can use ranges, proportional symbols etc. For this 
example choose Ranges. You can then select a style (don't worry if you don't like any of these as you can 
change them later - just choose one for now):

Now click the Next button to display Step 2.

 

Step 2
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The next step is to choose the table and data field (for ranged maps you can only display one field at a 
time, but with pie-charts for example you can select multiple fields). The table is the table containing the 
data - which in this case is the World map table, as it has a selection of variables included as attribute 
data (data relating to each graphic object in the table). To display the female population in 1994, select 
World as the table and Pop_Fem as the field (you can choose Pop_Male if you want to, or whatever you 
like… ):

You will notice a checkbox labelled Ignore Zeroes or Blanks. If your data table has zero values or blanks 
for any record, checking the Ignore Zeroes or Blanks box will leave these countries without colour (or 
the colour of the basemap if it has one).
If you do not check this and there are zeroes or blanks, they will be included in the lowest data category, 
which could be misleading. (To see the difference, leave it unchecked for now, but then create a thematic 
map again but with the box checked).
Click the Next button to move to Step 3. If the Next button is disabled then you have done something 
wrong, so check you have a valid table and field selected. 

 

Step 3
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You will now see a preview. Don't make changes for now, as any changes can be made in the Modify 
Thematic Map dialog which we will come on to in a moment: 

Click OK and you should now see the data mapped thematically!

 

Yuk, those colours just don't go together…

To modify how your data is displayed, open the Map menu (make sure that the map window is active) 
and click Modify Thematic Map… The previous dialog will now be displayed, but is now called Modify 
Thematic Map instead. You have three customise options, accessed by clicking the appropriate button: 
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The three choices are: 

1. Ranges

2. Styles

3. Legend

Click Ranges to display the Customise Ranges dialog, which allows you to change the method, number 
of ranges and rounding:
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If you make any changes here, the OK button changes to Recalc. Click this to recalculate your ranges. 

 

The Styles button displays the Customise Range Styles dialog:
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Here you can experiment with different colours. To change the range in this example to red through to 
yellow, click the top colour box and select red as the foreground colour. Do the same for the bottom box 
but this time select yellow. 
You will see that the colour range has been changed automatically - you do not need to change all the 
intermediate colours as well! By clicking the Options button, you can change the inflection point (the 
colours are ranged from each end of the scale in towards the inflection point - useful if you have positive 
and negative values (e.g. population increase/population decrease). Click OK to apply changes.

 

Make your map legendary
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Click the Legend button to display the Legend dialog. This allows you to determine the appearance of 
the legend:

:

You can start by changing the title to something better than World by Pop_fem, so just delete it and enter 
your choice of title. You can also add a subtitle if you wish. The font style for both title and subtitle can 
be changed.
You can edit the range labels, but remember that this does not change the actual ranges - you do that by 
clicking the Ranges button in the Modify Thematic Map dialog. By default the record count (the number 
of records in each range) is shown, so uncheck the Show Record Count box if you wish to remove them. 
When you have made any changes to the legend, go back to the layout window. If the legend has not 
appeared on the layout, you can now add it.
To do this, make sure that the Layout window is the active window (check it is visible and it has a blue 
title bar). To add the legend to the layout, you first draw a frame. Click the Frame tool (the button with a 
yellow square on the Drawing toolbox), then draw a box roughly where the legend will go. When you 
release the mouse you will see a dialog asking which window you wish to display - select Legend of 
World map in this case. The legend will now be displayed with a border. You can move and resize the 
legend as you wish, by clicking it then using the mouse. To move it, click on the legend and then drag. 
To resize it, click and drag one of the corner nodes.
The legend box is a region object, so you can choose a different border (or no border at all) or 
background colour by clicking the legend to select it, then clicking the Region style button (bottom left 
tool) in the drawing toolbox. Make any changes and click OK to change the appearance of the legend.

If you look at the Layer Control, you will see your thematic layer indented above its associated map 
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layer. You can use the layer control to show or hide this layer, or change its order in the stack, but note 
that it always stays attached to its map layer.

Remember: To save your thematic layer for future use, you must save your map in a Workspace!

Now that you can create a thematic map from existing data, you may want to go on to making thematic 
maps from your own data. To map your own thematic data, you use an existing boundaries map (such as 
a world map, or a map of districts or counties) and link your data to it. It's not difficult to do and you will 
find step-by-step instructions in the MapInfo How to guides 

 

I wish to make a point… (or several points, in fact)

Point data maps differ from thematic data maps in that the table containing the data has a hidden column 
attached which stores the window x,y point location and symbol data. This means that once the point 
data table has been created, it can be saved as a table. Also, it does not need an existing map to display 
data - it is a map in its own right (the table of world capital cities for example, is a point data table). As 
with thematic data maps, you will find step-by-step instructions in the MapInfo How to guides. 

 

Moving on…

You should now have a reasonable understanding of the basics of MapInfo (certainly enough to impress 
colleagues and casual onlookers…). You are now ready to use the MapInfo How to guides to create just 
the map you need, with multiple maps on a layout, your own data and painlessly exploring the mysteries 
of SQL, grid thematic maps and geocoding, so have fun!

Appendix A: Saving a workspace

Nigel James
Bodleian Library 2000
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Saving a workspace
This guide is intended primarily for Map Room users, but may be of interest to other University students and 
staff, or indeed the wider community. References to tables, folders etc., are not applicable outside the Map Room, 
so if you are located elsewhere, you should substitute your own.

 

MapInfo and the datasets available in the Bodleian Library Map Room can only be used for education and 
research purposes. It is not licensed for commercial publication or other purposes. There are also 
restrictions on the use of Ordnance Survey and Census boundary data - please ask for further information. 

 

Saving a Workspace

If you wish to save the map(s) you are working on, save them to a Workspace.
A workspace saves information about the tables you are using, any styles you have selected and objects 
in the cometic layer etc. It also saves the Layout Window (see next section). When you save files, you 
should create your own folder to save your files in. You should also use sub-folders when necessary to 
keep your various table and data files organised.

If you are working in the Map Room, all user folders are in a folder called USRFLDRS on drive D:

To create your folder, select drive D, then look through the list of folders and open the folder called 
usrfldrs.Click the New Folder button to create a new folder, naming it with your name. Open your folder 
and save your workspace. Obviously if you are working elesewhere then you will have to set up your 
own directories and folders, but the idea is the same.

Beware: A workspace does not save copies of any tables, simply paths to them, so do not delete or move 
any tables which are used by your workspace, as you will not be able to open it again (...and there will be 
a great wailing and gnashing of teeth…) 

To save a workspace, open the File menu and click Save Workspace. Select your folder and give the 
workspace a name. It will be saved with a .wor extension. The next time you wish to work with your 
maps, open the File menu and click Open Workspace. Find your .wor file and open it - your maps and 
layout will be recreated ready to continue working on them. 
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